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Abstract - All papers either Full 6 page papers, Work in 
Process papers, Special Sessions summaries, Panel 
Session summaries or Workshops summaries must 
include an Abstract with the submission.  The Abstract 
and Index Terms text should be 10 point Times New 
Roman, full justified and contained within one 
paragraph.  Begin the Abstract with the word Abstract - 
in Times New Roman italic.  The entire Abstract should 
be bold.  Do not Indent.  Use a standard dash not a long 
dash after the words “Abstract”.  Do not cite references 
in the abstract.  The abstract should be approximately 
150 - 200 words; this example abstract is 188 words, thus 
you can use the length of this abstract as an example of a 
standard abstract.  Avoid using abbreviations in the 
abstract.  A copy of this abstract will be copied and 
included in the conference program book so please follow 
these guidelines to ensure every presentation will have an 
abstract in the program book.  Also when you submit 
your paper online make sure you replace the existing 
abstract you have in the text box on the paper 
submission form with this new version. 
 
Index Terms - About four, alphabetical order, key words or 
phrases, separated by commas (for suggestions: Camera-
ready, FIE format, Preparation of papers, Two-column 
format). 

PAGE LAYOUT 

These instructions serve as a template for Microsoft Word, 
and give you the basic guidelines for preparing camera-
ready papers for the FIE 2008 conference (Frontiers in 
Education Conference), October 22 - 25, 2008 in Saratoga 
Springs, NY.  Please carefully follow the instructions 
provided in these guidelines to ensure legibility and 
uniformity.  The guidelines are designed to reduce the 
amount of white space and maximize the amount of text that 
can be placed on one page.  Please do not use LATEX.  If 

you wish to use Word Perfect, please save the file as a rtf 
file not a wpd file. 

When you open these guidelines, select "Print Layout" 
from the "View" menu (View | Print Layout), which will 
allow you to see the two-column format. You may then type 
over sections by using the cut and paste commands listed 
under the Edit menu (Edit | Paste) into this document and/or 
by using the markup styles.  We suggest you just use this 
document as your guide and simply cut and paste your 
text over the material in this document.   

The pull-down style menu is at the left.  Click on the 
down arrow to access the various styles (for example, the 
style at this point in the document is "First Paragraph").  
Scroll through the style list and you will find “First 
Paragraph” highlighted.  To use these built-in style guides, 
highlight a section that you want to designate with a certain 
style, and then select the appropriate name on the style pull-
down menu. 

PAPER LENGTH 

Full papers are limited to 6 pages.  Work in Progress papers 
are limited to 2 pages.  Panels, Special Sessions and 
Workshops should follow the Work In Progress paper 2 page 
length. 

OVERALL FORMAT SPECIFICATIONS 

All papers either Full Papers (6 pages), Work in Progress 
(Two page) or Panel, Special or Workshop  Sessions must 
follow the following layout:  
 
• 8 1/2" x 11" paper size 
• Portrait Orientation 
• Two-column format for the body of the document 
• Top margin: 0.75"  
• Bottom margin: 1.0"  
• Left and right margins: 0.75"  
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• Spacing between columns: 0.20"  
• Column width: 3.4"  
• Indents - first paragraph of section - none  
• Indents - all other paragraphs - .25"  
• Header and Footers 0.5 inches 

 
Set all these values using the "FILE" Menu.  Select the 

Page Setup – Margins tab option and click on portrait 
orientation option.  The above margin dimensions can then 
be inserted into the Page Setup Window.  Now select the 
Paper tab and click on the paper size and select the letter 
paper size.  Next select the Page Setup – Layout tab and set 
the Header and Footer to 0.5 inches.  To set the column 
width, click anywhere in the document within the two 
column format, then Select the Columns for the Format 
menu.  Click on the Equal Column Width and set the 
spacing.  Make sure you also apply to "This Section". 

While formatting your document, make consistent use 
of punctuation marks and spelling.  There are two basic 
systems used by American and British authors.  Either 
American or British is acceptable, but it must be consistent, 
(i.e. not a mix).  For example, 
• Putting commas and periods outside of quotation marks, 

e.g. ", and ". instead of ," and ."  The latter is American 
usage and the former is British. 

• Use of single quotes, e.g. 'service center' (British) rather 
than "service center" (American). 

• Or text such as grey and disc (British) vs. gray and disk 
(American). 

PAPER TITLE AND AUTHOR DATA 

The title and author data is in one-column format, while the 
rest of the paper is in two-column format. To accomplish 
this, most word processors have a section break that is 
installed to separate the one and two-column format.  There 
are two ways to setup this format: 1) Use this template as a 
guide, 2) make your own.  If you wish to make your own, it 
is suggested that you open a new document and begin by 
inserting the title and author information in the standard one-
column format.  Please adhere to the following style 
guidelines: 

 
• Paper title: This information should be placed at the 

top of the first page in 24 point, Times New Roman in 
Title case, and centered.  This style is defined under the 
style menu of this document as "TITLE". 

• Work in Progress:  All Work in Progress paper titles 
must begin with the words Work in Progress.  For 
example if your paper was titled “I Love College”, then 
the title on your submitted paper should be as follows: 
“Work in Progress – I Love College” 

• Panels, Special Sessions, Workshops:  All Panel, 
Special Session and Workshop titles must begin with 
the word(s) Panel, Special Session and Workshop.  For 
example if your paper was titled “I Love College”, then 

the title on your submitted paper should be as follows: 
“Panel – I Love College”, etc. 

• Insert a 11 point blank line between the Title and the 
Author listing and between the Author listing.   

• Author listing: 11 point, Times New Roman, centered.  
This style is defined under the style menu of this 
document as "Author".  For Special and Panel Session, 
list all panelists as authors.  Include only the author 
names in the author listing.  Use the full first name for 
the authors.  If an author is submitting more than one 
paper please provide the same name on both papers.  
For example, do not submit one paper as Dan Budny, 
the other as Dan D. Budny and a third as D.D. Budny.  
Be consistent as the name you provide on the paper will 
be what is used to create the author index for the 
proceedings. 

• Author Affiliations: 10 point, Times New Roman, 
centered under the author name.  This style is defined 
under the style menu of this document as "Affiliations".  
Information for each author such as email, department 
or college, university, city, state and zip can be listed.  If 
you list the email address make sure the Hyperlink is 
not attached.  If the email address turns a color that 
means the hyperlink is active.  Right click on the 
address and select Remove Hyperlink.  There are 3 
basic types of setups that will be encounter: One author, 
multiple authors from the same institution and multiple 
authors from multiple institutions.  If the paper has one 
author use the affiliation layout as shown at the top of 
this document where all the author information is listed 
under the paper title.  For multiple authors, from the 
same institution, list the common university, then list 
the email addresses at the end in the same order as the 
authors appear in the Author Listing.  For multiple 
authors from multiple institutions list the author names 
under the title, then list the author emails under their 
names.   Additional information for multiple authors can 
be added to the Author Information section at the end of 
the paper. 

PAPER BODY FORMAT 

The following Information is for either a "Full Paper", 
"Work in Process", “Special Session” “Workshop”, or 
"Panel Session".  Every presentation at the conference must 
have a submission.  For panel sessions, special sessions, or 
workshops the submission should be a review of the topic to 
be discussed, with a brief description of the topic for each 
presentation. 

I. Column Format Instructions 

The title and author data is in one-column format, while the 
rest of the paper is in two-column format. To accomplish 
this, most word processors have a section break that is 
installed to separate the one and two-column format. For 
example, in Word, under the Insert menu select Breaks – 
Continuous. 
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After you enter the title and author information enter a 
few blank lines and then insert a Continuous section break.  
Now you must define this section to be in two-column 
format.  To do this in Word, under the "Format" menu select 
"Columns". This option will open the Columns window.  It 
has an input box for the number of columns. Enter 2 and 
then set the spacing to 0.2" and select equal column widths.  
If you have the margin widths set correctly, the width of the 
column should display as 3.40".  If it does not, go to the 
"File" menu and select “Page Setup - Margins”. This will 
open the "Page Setup" window that will allow you to set the 
top and bottom margins to 1" and the right and left margins 
to 0.75".  Every word processor will have its own method of 
accomplishing the above setting, however, most follow the 
same format. 

For "Work in Process" or "Panel Session" submissions, 
if the paper does not fill the entire page and covers more 
than 4 inches of the first column, please balance the paper 
within the two-columns.  The easiest way to do this is to 
insert a section break at the end of the document. 

II. Font and Spacing Instructions 

Use the full justify option for your columns, and use two-
columns in all pages. The two columns must always exhibit 
equal lengths and you should try to fill your last page as 
much as possible. To obtain such results, you are free to 
adjust the figure sizes provided this does not compromise 
their clarity. Use one line of space between text and section 
headings. Use one line of space between text and captions, 
equations, and tables. Use the spelling and grammar 
checkers.  Do not use the “hyphenation” feature in Word. 
Please use the following font and alignment instructions: 
• Body text: 10 point, Times New Roman, full justified, 

single space, no blank lines between the paragraphs. 
Indents - first paragraph of section - none (this style is 
defined under the style menu of this document as "First 
Paragraph"), Indent - all other paragraphs - .25" (this 
style is defined under the style menu of this document 
as "Body Text").  Follow the examples shown in this 
document. 

• Section Headings: 10 point, Times New Roman, bold, 
centered, use SMALL CAPS, leave one blank line above 
and below.  For example, "Page Layout" on page one of 
this document is a Section Heading (this style is defined 
under the style menu of this document as "Section 
Headings").  To convert the text to small caps, click on 
the “Home” tab, and select the pull down arrow in the 
“Font” submenu.  This will open the “Font Window” 
where you can select the Small Cap option. 

• Section Sub-headings: 10 point, Times New Roman, 
italic, left justified, leave one blank line above and 
below.  For example, "Font and Spacing Instructions" 
on this page is a Section Sub Heading (this style is 
defined under the style menu of this document as 
"Subheading"). 

• Bullets: 10 point, Times New Roman, left justify and 
indent the text 0.25".  Insert a blank line after the bullet 

list but not before, follow the examples in this document 
(this style is defined under the style menu of this 
document as "Bullets"). 

III. Page Numbering 

The page number on your manuscript is centered at the 
bottom of the footer.  The final page number will be 
modified by the conference before the file is saved into the 
proceedings 

FIGURES, TABLES AND EQUATIONS 

All figures and tables must fit either one or two-column 
width, 3.4" or 7" wide respectively.  It is suggested that you 
use one-column whenever possible.  If your table or figure 
will not fit into one-column, then insert a continuous section 
break before and after the table or figure, as described above 
and define it as one-column.  To make the paper read easier 
you may want to position any table or figure that requires 
one-column either at the bottom of the page or the top of a 
new page. 

Do not abbreviate “Table”; use Roman numerals to 
number tables. Use the following format guidelines for 
Figures and Tables: 
• Figure and Table headings: 8 point, Times New 

Roman UPPERCASE, centered. Place below the figure 
and above the Table, (this style is defined under the 
style menu of this document as "Figure Heading") 

• Leave one blank line above and below each Table or 
Figure.  

• Figure and Table captions: 8 point, Times New 
Roman, SMALL CAPS, centered.  Place below the figure 
or table headings (this style is defined under the style 
menu of this document as "Figure Caption") 

• Table text: 8 point, Times New Roman, (this style is 
defined under the style menu of this document as "Table 
text") 
 
Table I and Figure 1 below illustrates proper Table and 

Figure formatting.  Avoid placing figures and tables before 
their first mention in the text.  IEEE has the following rules 
for inserting graphics as figures: 
• The manuscript’s graphics should have resolutions of 

600 dpi for monochrome, 300 dpi for grayscale, and 300 
dpi for color. 

• Graphics should be inserted into the manuscript file 
using the “Insert – Picture – From File” option in the 
“Insert” tab.  This means you must save every graphics 
as a separate file.  Do not use cut and paste to insert 
graphics. 

• Do not link to a graphic.  When inserting figures or 
tables be sure you insert the figure and not just a link to 
the figure.  The best way to make sure you are doing 
this correctly is to save your paper, then open the file on 
a different machine and make sure all your figures are 
correct.  If you insert the link instead of the figure or 
table, a box with a big red x will appear in the location 
where the table or figure is supposed to be located. 
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TABLE I 

POINT SIZES AND TYPE STYLES 
Points  Place of Text Type Styles 
8 
8 
8 
8 
8 
8 
10 
10 
10 
10 
10 
10 
11 
24 

Table number 
Table text 
Figure and Table Headings 
Figure and Table Captions 
Footnote 
Reference list 
Footer 
Abstract 
Index Terms 
Section Titles 
Main Text and Equations 
Subheadings 
Authors’ names 
Title  

ROMAN NUMERALS 
 
UPPERCASE 
SMALL CAPS 
 
 
Bold 
Bold 
 
SMALL CAPS, BOLD 
 
Italic, Left justified 
 
Title Case 

 
 

                                                  
 

FIGURE 1 
LOGO OF THE  INSTITUTE FOR ELECTRICAL AND ELECTRONICS ENGINEERS. 

 
Number equations consecutively with equation numbers 

in parenthesis flush with the right margin, as in (1) 
 
       2jk ∂u/∂z  =  ∂2u/∂x2 + k2 (n2 - β2) u .                  (1) 
 
Refer to “(1)”, not “Eq. (1)” or “Equation (1)”, except at 

the beginning of a sentence: “Equation (1) is…”.  
Make sure you only use the “Symbol Font” for all your 

symbols, or embed all your different symbol fonts within the 
file when you save the document. 

HEADERS AND FOOTERS 

Select Page Layout tab, select Margins – More Margins.  
This will open the Page Setup Window, select the Layout 
tab.  Set the Header and Footer to 0.5 inches.  Please use the 
following format guidelines for the Header and Footer: 
 
• Header text: should say Session T1A as shown on the 

top of this document.  Once your paper is assigned to its 
final session, the Publications Chair will modify this to 
the correct session.  Text should be 14 point Times New 
Roman, right justified, bold (this style is defined under 
the style menu of this document as "Header") 

• Footer text: should be 10 point Times New Roman, 
bold (this style is defined under the style menu of this 
document as "Footer").  The text of the footer should 
say the same as shown on the bottom of this document.  
Please copy and paste this information into your 
document exactly as shown on this page.  Once your 
paper is assigned to its final session, the Publications 
Chair will modify the page number to the correct 
session.   
 

ACKNOWLEDGMENT 

The preferred spelling of the word "acknowledgment" in 
American English is without an "e" after the "g." Use the 
singular heading even if you have many acknowledgments.  
Please put the sponsor acknowledgments in this section do 
not use a footnote on the first page. 

COPYRIGHT FORM 

An IEEE copyright form should accompany your final 
submission. You can get one at the conference web site, 
under Authors. Follow the instructions posted on the web. 

IN TEXT REFERENCES 

All material from any research resource must be 
accompanied by a bracketed in-text reference.  This 
reference must correspond to its end-text full bibliographic 
information in the References section.  Failure to properly 
reference all resource material used in a paper leaves the 
paper’s author open to charges of plagiarism. 

Follow these specifications for in-text references: 
 

 Bracket all in-text references, for example [1]. 
 In text references must be numbered sequentially in 

the text, beginning with [1] for the first reference.  In 
other words, the first source from which you quote, 
paraphrase or use information must be referenced in 
your paper as [1].  The next source from which your 
quote, paraphrase or use information must be [2].  If, 
later in your paper, you use information from the same 
source and same page as [1], then your in-text reference 
number will again be [1].  

 Do not use “Ref. [3]” or “reference [3].” Simply use the 
bracketed number. 

 For material summarized from several sources, use the 
appropriate bracketed numbers, for example [3]-[5]. 

 Bracketed reference numbers should appear after the 
quotation marks on an in-text quote, but before the final 
punctuation of the quote.  For example, “Here’s the 
quote” [3].  Bracketed references for paraphrases or 
summaries should appear after the paraphrase or 
summary, but before the final punctuation of the 
sentence or passage.  For example, Here’s the 
paraphrased material [4]. 

REFERENCES 

Place references in a separate References section, do not 
footnote references.  Number the references sequentially by 
order of appearance not alphabetically.  Refer simply to the 
reference number, as [3] or [5]-[8]. Do not use “Ref. [3]” or 
“reference [3]” except at the beginning of sentence: 
“Reference [3] shows….”. Provide up to five authors’ 
names; replace the others by “et al.”  Do not put figures or 
anything else after the references.  
• Reference text: 8 point, Times New Roman, full 

justified, no space between the references (this style is 
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defined under the style menu of this document as 
"References") 

• Use box numbers with square brackets [ ] within text. 
Do not use superscripts or subscripts.  Do not use ( ) for 
references, since these are used to refer to equations.  
 
Use the following as the guide for references: 
 

[1] Author's Last name, First initial, Middle initial, "Title", Journal or 
book (italics), Vol, No #., date, pp.  

[2] Author's Last name, First initial, Middle initial, "Title", Journal or 
book (italics), Vol, No #., date, pp. 

AUTHOR INFORMATION 

If your paper has multiple authors, use this section to list 
author information.  For Example: 
 
Dan Budny Publications Chair, University of Pittsburgh, 
budny@pitt.edu. 
 
Cherrice Traver, General Chair, Union College, 
traverc@union.edu 
 
Matthew Ohland, ASEE/ERM Program Co-Chair, Purdue 
University, ohland@purdue.edu 

 
Jane Prey, IEEE/Computer Society Program Co-chair, 
Microsoft Corporation, jprey@microsoft.com 
 
Tony Mitchell, IEEE/Education Society Program Co-chair, 
North Carolina State University, tmitchel@eos.ncsu.edu 
 
Jeff Froyd, Special Sessions & Panels Chair, Texas A&M 
University, froyd@tamu.edu 
 
Ann Anderson, Workshop Chair, Union College, 
andersoa@union.edu 
 
Edmundo Tovar Caro, International Co-Chair, Europe, 
Universidad Politecnica de Madrid, etovar@fi.upm.es 
 
Melany M. Ciampi, International Co-Chair, South America, 
Vice-President, COPEC-Council of Researches in Education 
and Sciences, melany@copec.org.br 
 
Javier Quezada, International Co-Chair, Central America, 
Technologico de Monterey, jquezada@itesm.mx 
 
 

 


